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1. Updated version of the note 

Version Update Description Table 

Version NO. Content Date 

V1.0 
1. Added quick start guide and interface functions for 

spectrum analyzer; 

2. Added GNSS user manual; 

3. Added analog IF output support; 

4. Added IP address modification guide for NX series 

instruments; 

5. Added PX remote control guide. 

2025-7-30 

V1.1 1. Added a GNSS version description section, distinguishing 

the connection steps for the old and new GNSS modules 

2. Added a section on outputting and viewing the simulated 

intermediate frequency (IF) signa 

3. Added a section on OTG connection. 

2025-9-4 
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2. System requirements 

SA/NX series are core instruments, and their spectrum analysis software must be installed on 

a host computer. The recommended host system requirements are listed in the table below: 

The table provides only basic recommended configurations. For systems below these 

specifications, please verify with actual test results. 

Table 1 System Requirements 

Operating System Windows 11/10/8/7, (requires VS2019 C++ redistributables) 
Ubuntu 22.04/20.04/18.04, Debian 12/11/10, Raspberry Pi OS 64bit 

Architecture Windows: x64, AArch64 (NX instruments only) 
Linux: x64, AArch64 

Processor Windows: Intel i3 or higher; AArch64 tested only on Snapdragon 8CX 
Gen2 
Linux: Tested on Raspberry Pi 4B, PK3399, PK3588, etc. 

Memory 4 GB or higher 

Storage For IQ signal recording: Ensure sustained write speeds exceed 400 
MBytes/s 

Data Interface USB 2.0 or USB 3.0 (USB 3.0 recommended) 
IQ recording bandwidth and duration are limited by interface bandwidth 

Display Minimum resolution: 1280×800 pixels 

Other Notes Some antivirus software may cause system instability 
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3. SA Series Quick Start Guide 

This chapter is a quick start guide to the SA Series, featuring safety instruction, using 

instruments, running the software and external interface description. 

3.1 Safety Instruction 

  Power Adapter Selection 

1. Primary Option: Always use the original manufacturer-provided power adapter. Alternative: 

If unavailable, select a compatible adapter with specifications matching those outlined in 

the product manual. 

2. DC power supply requirements: voltage: 5 V ± 0.25 V (4.75 V – 5.25 V), current: minimum 2 A; 

peak ripple maximum 200 mVp. 

    Violation of specifications may result in damage to the instrument, follow the product 

manual strictly. 

  RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

3.2 Using SA Series Instruments 

  Connecting the Device 

1. Connect the instrument's power port to the power adapter using the Type-C cable and plug 

it into the socket; 

2. Connect the instrument's data port to a computer or embedded device using a Type-C 

cable, USB 3.0 is recommended for best performance. 

Important Note: It requires for 3 seconds for SA Series instruments operating normally after 

power-on. 

 

Figure 1 SA series connection diagram 

  Driver Installation (Windows) 

The following part presents the instructions for driver installation using Windows 10 x64 as an 

example. Note: Windows 11 is compatible with Windows 10 drivers. 

1. Check the computer system information, confirm the system version and number of bits; 
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2. Open the "Windows\HTRA_Driver\Win10_x64" folder in the supplied USB flash; 

3. Right-click the "Install_Driver.bat" file and select "Run as administrator" from the pop-up 

menu to initiate driver installation; 

 

Figure 2 Installation of drivers 

4. The terminal appears "USB Driver Installation Succeeded" prompt, it means that the driver 

installation success. 

  Driver Installation (Linux) 

The following will be an example of installing the driver in Ubuntu 18.04. 

1. Copy the "Linux" folder from the supplied USB flash to the system; 

2. Right-click on the "Linux/Install_HTRA_SDK" folder and select "Open in Terminal" to open 

the terminal; 

3. In the terminal type "sudo sh install_htraapi_lib.sh" and enter, according to the prompts to 

enter the current user password, and then enter again to confirm the installation; 

4. After connecting the instrument, input "lsusb" in the terminal, such as ID:6430, ID:3675, 

ID:04b5 or ID:367f, it means the driver installation is successful. 

 

Figure 3 Linux to see if the instrument is properly connected 

3.3 Running the software 

By default, the instrument is properly connected and the driver is installed. 

1. Copy the software folder in the "Windows" directory of the supplied USB flash drive to the 

desktop or other directories of your computer; 

2. 2. Enter the "\bin" folder in the software directory, run the executable program, and the 

spectrum display interface will be as follows. 
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Figure 4 Initial software display 

3.4 External Interface Description 

  SAN Series and SAM Series 

 

Figure 5 SAN and SAM Series Instrument Interface Description 

Table 2 SAN Series and SAM Series Interface Description  

Pin Interface Name Description 

1 RF Input SMA (F), Input Impedance 50 Ω 

2 RF Output SMA (F), Output Impedance 50 Ω (Available with "Built-
in Signal Source" option) 

3 Reference Clock Input MCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 
Supports Sine, Square, Peak Clipping Sine 

4 Power Port Instrument Charging Port, Type-C 5 V 2 A 

5 Data Port Type-C, USB 3.0 Recommended (USB 2.0 compatible, 
but bandwidth limited) 

6 Multifunctional MUXIO For a detailed description, please refer to Table 3. 
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Table 3 Description of Multi-function MUXIO PIN Interface of Port 6 (Illustration direction 

from left to right) 

Pin Name Direction Level Standard Meaning 

A1 GND / / Ground 

A2 NC / / / 

A3 EXT_TRG-IO1_F I 3.3 V External trigger 
input, up to 500 
times/s. 

A4 VEXT O / Power Output, 5 
V 

A5 GND / / Ground 

A6 USART6_TX_F / / / 

A7 USART6_RX_F / / / 

A8 NC / / / 

A9 VEXT O / Power Output, 5 
V 

A10 EXT_TRG-IO2_F O 3.3 V External trigger 
output 

A11 USART6_IT_F / / Reserved 

A12 GND / / Ground 

  SAE Series and SAN-400 Series 

 

Figure 6 SAE and SAN-400 Series Instrument Interface Description 
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Table 4 SAE Series and SAN-400 M2 Interface 

Pin Interface Name Description 

1 RF Input 
SAE-90 series instruments: SMA (F), input impedance 50 ʢ  
SAE-200/SAN-400 series instruments: 2.92 mm (F), input 

impedance 50 ʢ 

2 
Analogue IF 
output 

MMCX (F), maximum output power -25 dBm, output 
impedance 50 Ω 

3 
Reserved 
interface 

/ 

4 
Reference 
Clock Input 

MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 
Supports Sine, Square, Peak Clipping Sine 

5 
Multifunctional 
MUXIO 

For a detailed description, please refer to Table 5. 

6 
Heat dissipation 
vent 

/ 

7 Data port 
Type-C, USB 3.0 Recommended (USB 2.0 compatible, but 
bandwidth limited) 

8 Power port Instrument Charging Port, Type-C 5 V 2 A 

Table 5 Description of Multifunctional MUXIO PIN Interface of Port 5 (Illustration direction 

from left to right) 

Pin Name Direction Level Standard Meaning 

1 EXT_TRG_IO1 I 3.3 V Trigger input, up to 500 
times/s 

2 EXT_TRG_IO2 / / Reserved 

3 EXT_TRG_IO3 O 3.3 V Trigger output 

4 GND / / Ground 

5 LFADC_INA I / Low Frequency ADC 
Input 

6 3V3D O / Power output, 3.3 V 
Output 

7 USART9_RX / / / 

8 GND / / Ground 

9 USART_TX / / / 

10 NC / / / 

11 NC / / / 

12 NC / / / 

13 GND / / Ground 

14 REFCLK_OUT O / Reference clock output, 
can output 10 MHz 
standard clock signal 
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4. NX Series Quick Start Guide 

This chapter is a quick start guide to the NX Series, featuring safety instructions, instrument use, 

runtime software and external interface descriptions. 

4.1 Safety Instructions 

  Power Adapter Selection 

1. Primary Option: Always use the original manufacturer-provided power adapter. Alternative: 

If unavailable, select a compatible adapter with specifications matching those outlined in 

the product manual. 

2. DC power supply requirements: voltage: 5 V ± 0.25 V (4.75 V – 5.25 V), current: minimum 2 A; 

peak ripple maximum 200 mVp. 

    Violation of specifications may result in damage to the instrument, follow the product 

manual strictly. 

  RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

4.2 Using the NX Series Device 

  Connecting the Device 

1. Connect the instrument's power port to the power adapter using the Type-C cable and plug 

it into the socket. 

2. Use a network cable to connect the Gigabit network port (LAN2) of the instrument to the 

network port of the computer or embedded device for optimal performance (100 Mbps for 

LAN1 and 1 Gbps for LAN2). 

Note: NX series instruments need about 40 s to complete the self-start after power on, please 

wait patiently. Long press the power button for more than 5 seconds to switch off the 

instrument. 

 

Figure 7 NX Series connection diagram 



 

Spectrum Analyzer Quick Start Guide 9 
 

  Configuring the Network 

NX Series Instrument Network Configuration Instructions: 

Á IPv4 address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable) 

Á Subnet mask: "255.255.255.0" 

Á Bridge mode: enabled (LAN1/LAN2 logical interworking) 

Á Network access: via LAN1 (100 Mbps) or LAN2 (1 Gbps) 

The host computer needs to set the IP of the same network segment as the NX instrument (e.g. 

"192.168.1.X" or "192.168.3.X") in order to be used normally, and the IP address of the host 

computer can be configured as follows: 

1. Open "Settings" -> select "Network & Internet" -> select "Ethernet"; 

2. Enter Ethernet, find the IP section and click "Edit"; 

3. Select "Manual" mode and enable "IPv4", set the IP to "192.168.1.2" and the subnet mask to 

"255.255.255.0". Set the IP to "192.168.1.2" and subnet mask to "255.255.255.0"; 

4. Open the command prompt (Win + R -> enter "cmd"), the implementation of the command 

"ping 192.168.1.100", if you receive the following reply, it means that the network connection 

is successful. 

 

Figure 8 Test instrument network connectivity (ping command) 

4.3 Running the software 

The default instrument is properly connected and the network is successfully configured 

according to the above sections. 

1. Copy the software folder in the Windows directory of the supplied USB flash drive to the 

desktop or other directory of your computer; 

2. Enter the "\bin" folder in the software directory, run the executable programme, and the 

spectrum display interface will be as follows. 
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Figure 9 Initial software display 

4.4 External Interface Description 

  NXN and NXM Series 

 

Figure 10 NXN and NXM Series Instrument Interface Description 

Table 6 NXN Series and NXM Series Interface Description  

Pin Interface Name Description 

1 
Reference Clock 
Input 

MCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 
Supports Sine, Square, Peak Clipping Sine 

2 RF Output 
SMA (F), Output Impedance 50 Ω (Available with "Built-
in Signal Source" option) 

3 RF Input SMA (F), input impedance 50 Ω 

4 USB Type-C, USB 2.0 
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5 
GNSS antenna 
input 

MMCX (F) 

6 Trigger output MMCX (F), 3.3V CMOS 

7 Trigger input 
MMCX (F), 3.3V CMOS, high-impedance input, max 
trigger rate 500 times/s 

8 
Reference Clock 
Output 

Provides high quality 10 MHz clock signal when 
equipped with internal DOCXO 

11 12 13 
Reserved 
Interface 

/ 

9 
Multifunctional 
MUXIO 

For a detailed description, please refer to Table 7. 

10 4G Antenna Input MMCX (F) 

14 
Instrument 
Switch 

Switch the instrument on/off. The instrument starts up 
automatically on first power-up, eliminating the need to 
manually press the switch. During power-up, the 
instrument can be switched off and on again with a 
switch. 

15 Power Port Type-C PD3.0 12 V 2 A/9 V 2 A 

16 LAN1 Fast Ethernet Port (100 Mbps) 

17 LAN2 Fast Ethernet Port (1 Gbps) 

Table 7 Description of Multifunctional MUXIO PIN Interface of Port 9 (Illustration direction 

from right to left) 

Pin Name Direction 
Level 
Standard 

Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / Power output, 5 V output 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 11 12 NC / / / 

13 GND / / Ground 

14 REFCLK_OUT_FP O / Reference Clock Output, Outputs 
10 MHz std. clock 
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  NXE Series and NXN-400 

 

Figure 11 NXE and NXN-400 Series Instrument Interface Description 

Table 8 NXE and NXN-400 Series Interface Description 

Pin Interface Name Description 

1 RF Input NXE-90 series instruments: SMA (F), input impedance 50 
Ω  
NXE-200/NXN-400 series instruments: 2.92 mm (F), 
input impedance 50 Ω 

2 USB Type-C, USB 2.0 

3 Multifunctional 
MUXIO 

For a detailed description, please refer to Table 9. 

4 GNSS Antenna 
Input 

MMCX (F) 

5 Trigger Output MMCX (F), 3.3V CMOS 

6 Trigger Input MMCX (F), 3.3V CMOS, high-impedance input, max 
trigger rate 500 times/s 

7 Reference Clock 
Input 

MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 
Supports Sine, Square, Peak Clipping Sine 

8 4G Antenna Input MMCX (F) 

9 Analog IF Output MMCX (F), Max Output Power -25 dBm, Output 
Impedance 50 Ω 

10 11 Reserved 
Interface 

/ 

12 Instrument Power 
Switch 

Switch the instrument on/off. The instrument starts up 
automatically on first power-up, eliminating the need to 
manually press the switch. During power-up, the 
instrument can be switched off and on again with a 
switch. 

13 Power Port Type-C PD 3.0 12 V 2 A/9 V 2 A 

14 LAN1 Fast Ethernet Port (100 Mbps) 

15 LAN2 Fast Ethernet Port (1000 Mbps) 
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Table 9 Pin 3 Multi-function MUXIO Pin out Description (Pins ordered right-to-left in 

diagram) 

Pin Name Direction 
Level 
Standard 

Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / 
Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / Power Output, 3.3V Output 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 SYNC_RXRFLO / / Reserved 

11 SYNC_ADCCLK / / Reserved 

12 SYNC_RXIFLO / / Reserved 

13 GND / / Ground 

14 REFCLK_OUT_FP O / Reference Clock Output, Outputs 
10 MHz std. clock 
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5. PX Series Quick Start Guide 

This chapter is a quick start guide to the PX Series, featuring safety instructions, instrument use 

and external interface descriptions. 

5.1 Safety Instruction 

  Safety Rules 

Á Appearance check: make sure that the instrument is in good condition and free from 

damages 

Á Accessory check: no damage to power cord, adapter 

Á Ventilation check: fan vents are kept clear 

Á Environment check: the instrument is dry and free of moisture and condensation, and the 

ambient temperature meets the requirements of the product specification 

Á Operation monitoring: Ensure that the fan is working properly and that the working 

temperature and humidity are in accordance with the product specifications 

Á Connection specification: all external interfaces are correctly connected and the RF input 

signal level meets the requirements of the product specification 

Á Power management: maintains battery at >5% of capacity 

Á Storage requirements: the instrument is completely switched off, and the temperature and 

humidity of the storage environment meets the requirements of the product specification 

    Abnormal handling: Any damage or malfunction is found, please contact the official after-

sales service in a timely manner 

    Safety warning: It is strictly forbidden to open the shell of the instrument (to prevent electric 

shock) 

  Power adapter selection 

Adapter Selection: Prefer the original matching power adapter. Alternative: Refer to the 

product manual to select the adapter with matching specifications. 

    PXZ instruments must use the original factory-mounted power adapter; third-party 

alternatives are not supported. 

    Violation of specifications may result in damage to the instrument, follow the product 

manual strictly. 

  RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

  Replacing the Power Adapter 

PX series instruments support the replacement of batteries, if you need to replace, please 

contact the official after-sales service channel to deal with, do not disassemble the instrument. 

5.2 First Use of the Instrument 

The instrument has been transported over a long distance, the battery power may be below 5%, 

it is recommended to connect the supplied power adapter before the first use, and then switch 

on the instrument. 
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  Switching the instrument on and off 

The instrument is switched on/off by the power button on the top of the instrument. When the 

instrument is switched on, the power indicator light is on; when it is switched off, the power 

indicator light is off. 

  Charging Indicator 

When the instrument is connected to the power adapter, the charging status light flashes green 

to indicate that it is charging. When the battery is fully charged, the charging indicator light will 

change to a green constant light. 

  Running the Software 

Press the power button, the instrument will enter the desktop environment after powering on 

and start the software automatically. 

5.3 External Interface Description 

 PX Series 

All interfaces of the instrument are integrated in the top panel for user-friendly operation, 

please refer to Table 10 for detailed description of each interface. 

 

Figure 12 PX Series Instruments Upper Board Interface Description 

Table 10 PX Series Interface Description 

No Interface Name Description 

1 Power Button On/Off instrument 

2 Charging port 
Instrument charging port, USB PD3.0 20 V 3.25 A, 
please connect the power supply according to the 
instrument's required operating voltage 

3 Micro HDMI For extended display 

4 USB3 USB interface: USB3 is USB 3.0 interface, USB1 and 
USB2 are USB 2.0 interface. This interface connects to 
external storage devices, USB keyboards, or mice. It 
can also be used to connect a driver-free Hub with an 
Ethernet port, allowing the instrument to be remotely 
controlled by a PC via network cable 

5 USB2 

6 USB1 
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7 Audio Output 
3.5mm headphone jack. Volume can be adjusted via 
the menu: "System" -> "Device" -> "Volume." 

8 
Multifunctional 
MUXIO 

For a detailed description, please refer to Table 11. 

9 Charging Indicator 
Green flashing means charging, green always on 
means full. 

10 Analogue IF output 
MMCX (F), max. output power -25 dBm, output 

impedance 50 Ω 

11 Trigger Output 3.3V CMOS 

12 Trigger Input 
MMCX (F), 3.3V CMOS, high-impedance input, max 
trigger rate 500 times/s 

13 
Reference Clock 
Input 

MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 
Ω. 
Supports Sine, Square, Peak Clipping Sine 

14 GNSS Antenna MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω 

15 RF Input 
PXE-200: N (F), input impedance 50 Ω 

PXN-400: 2.4mm (M), input impedance 50 Ω 

Table 11 Pin description for MUXIO interface 8 (from left to right) 

Pin Name Direction 
Level 
Standard Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / 
Power Output, PXN-400 and 
PXE Series 5 V Outputs 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 
SYNC_RXRFL
O 

I 3.3V RF LO synchronization 

11 
SYNC_ADCCL
K 

I 3.3V ADC clock synchronization 

12 SYNC_RXIFLO I 3.3V IF LO synchronization 

13 GND / / Ground 

14 
REFCLK_OUT_
FP O / 

Reference clock output for 10 
MHz standard clock signals 
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 PXZ Series 

Please refer to the following table for detailed information on each interface12. 

 

Figure 13 PXZ Series Instruments Upper Board Interface Description 

Table 12 PXZ Series Interface Description 

No Interface Name Description 

1 RF Input 
PXE-200 Z: 2.92mm (M), input impedance 50 Ω 

PXN-400 Z: 2.4mm (M), input impedance 50 Ω 

2 Charging port Instrument charging port, USB PD (100W) 

3 External Antenna Input 
MMCX (F), amplitude ≥ 1.5 Vpp, input impedance 330 

Ω 

4 Reference Clock Input 
MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 
Supports Sine, Square, Peak Clipping Sine 

5 Multifunctional AUXIO For a detailed description, please refer to Table 13. 

6 loudness Increase/decrease instrument volume 

7 USB 

USB3.0 interface. Through this interface to connect the 
external expansion memory and USB keyboard, mouse; 
or connect the driver-free Hub with network port, 
through the network cable to connect to the PC, the PC 
to the instrument for remote control 

8 SD Card Slot 
Supports microSD, microSDHC or microSDXC memory 
cards for transferring data between the card and the 
instrument 

9 Charging Indicator 
Green flashing means charging, green always on means 
full. 

10 GNSS Indicator Blue indicates GNSS locked 

11 Audio Output 
3.5mm headphone jack. Volume can be adjusted via the 
menu: "System" -> "Device" -> "Volume." 

12 Power Button Switching the instrument on/off 
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Table 13 Port 5 Multi-function AUXIO PIN Connector Description (A1-A12 shown from left to 

right B1-B12 shown from right to left) 

Pin Name Direction 
Level 
Standard 

Meaning 

A1/A12 GND / / Ground 

A2-A3 
A5-A8 
A10-A11 

/ / / Reserved 

A4/A9 VBUS OUT O / Power supply 5 V output 

B1/B12 GND / / Ground 

B2 REFCLK_OUT O / 
Reference clock output for 10 
MHz standard clock signals 

B3 TRG_IO2 O / Trigger output, 3.3V CMOS 

B4/B9 VBUS OUT O / Power supply 5 V output 

B10 
B5-B8 

/ / / Reserved 

B11 EXT_TRGIN I / 

External trigger input, 3.3V 
CMOS input impedance is high 
resistance, maximum 
frequency response 500 
times/s. 
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6. GNSS Application Instructions 

This chapter explains how to identify the version of the accompanying GNSS module and how 

to obtain real-time positioning data using either the internal or external GNSS module. The 

internal module is provided with the instrument, while the external module is selected by the 

user. 

6.1 Version Information 

The instrument is currently provided with two versions of GNSS modules: Version A is the old 

version, and Version B is the new version. Both versions are functionally identical, with the only 

difference being the power supply method. Please refer to the following appearance diagrams 

to identify the module version in use, and strictly follow the instructions in the corresponding 

version’s chapter for connection to ensure the stable operation of the GNSS module. 

 

Figure 14 GNSS Module Version A 

Appearance 

 

Figure 15 GNSS Module Version B 

Appearance 

6.2 GNSS options 

  Options Overview 

The following accessories are for SA series instruments. NX/PX series instruments have built-

in GNSS modules, so to use the GNSS function, you only need to connect the antenna, and do 

not need to connect the accessories listed below. 

Note: 1PPS and 10MHz clock signal outputs from GNSS are not recommended when the GNSS 

module is unlocked. 
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Version A Standard GNSS 

Module 

 

Version A High-Precision GNSS 
Module 

 
Version A High-Quality GNSS 

Module 

 

Version B Standard GNSS 

Module 

 

Version B High-Precision GNSS 

Module 

 
Version B High-Quality GNSS 

Module 

 
Ribbon Cable 

(Connection of external GNSS 
modules and SA series 

instruments) 

 
MMCX-to-SMA Cable 

(Connection of antenna and 
GNSS module) 

 
MUXIO Multi-Function to Type-C 

Adapter 
(Connection of SAM/SAN series 

and rows of wires) 

 

MCX-to-MMCX Cable 
(Connection of the reference input of the 

SAM/SAN instrument and the reference output of 
the GNSS module) 

 

MMCX Cable 
(Connection of the reference input of the 

SAE/SAN-400 instrument and the reference 
output of the GNSS module) 
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  Interface Description 

  

  

  

1 External GNSS Antenna Interface 6 Reserved Interface 

2 External Reference Input Interface 7 Auxiliary Power Supply Type-C 

Interface (only applicable to high-

quality GNSS modules) 

3 External Trigger Input Interface 8 MUXIO Multi-Function Interface 

(Trigger Input/Output) 

4 Trigger Output Interface 9 Analog Intermediate Frequency (IF) 

Input Interface (for SAE/SAN-400 

devices) 

5 Analog Intermediate Frequency (IF) 

Output Interface (for SAE/SAN-

400 devices) 

10 10MHz Reference Clock Output for 

High-Quality GNSS Modules 
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6.3 Connection of Internal GNSS Module (Version A) 

 SAE/SAN-400 Series 

The operating steps for connecting Version A GNSS option to the SAE/SAN-400 series 

instrument are as follows: 

1. Instrument connection: Instrument No. 5 MUXIO interface -> GNSS module No. 8 MUXIO 

interface (with the ribbon cable), GNSS module indicator light blinking that is connected 

successfully. 

2. External GNSS antenna connection: antenna -> GNSS module No. 1 interface (with MMCX 

to SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality modules only): use a Type-C cable to connect 

the GNSS module's No. 7 interface to the power adapter and plug it into an outlet. 

4. Reference clock connection (high-quality module only): MMCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with double-ended MMCX 

cable). 

 

Figure 16 SAE/SAN-400 Module Connection with Version A GNSS Module Diagram 

 SAM/SAN Series 

The operating steps for connecting Version A GNSS option to the SAM/SAN series instrument 

are as follows: 

1. Instrument Connection: Instrument No.6 MUXIO interface -> GNSS module No.8 MUXIO 

interface (with MUXIO to Type-C and Ribbon Cable), GNSS module indicator light blinks 

that the connection is successful. 

2. External GNSS antenna connection: antenna -> GNSS module 1 interface (with MMCX to 

SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality module only): Use a Type-C cable to connect the 

GNSS module's No. 7 connector to the power adapter and plug it into an outlet. 

4. Reference clock connection (high quality module only): MCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with MCX to MMCX cable). 
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Figure 17 SAN/SAM Module Connection with Version A GNSS Module Diagram 

 NX Series 

The NX series instruments have built-in GNSS modules. To use them, you only need to connect 

the antenna, and the receiving side of the antenna is facing to the unobstructed sky. The 

procedure is as follows: 

1. NXE/NXN-400 series: Antenna -> Instrument 4 GA interface (with MMCX to SMA cable). 

2. NXM/NXN series: Antenna -> Instrument 5 GA interface (with MMCX to SMA cable). 

  PX Series 

The PX series instruments have built-in GNSS modules. To use them, you need to connect an 

external GNSS antenna (with the receiving side facing the unobstructed sky) to the instrument's 

No. 14 GA interface via the MMCX to SMA cable. 

  PXZ Series 

PXZ series instruments have built-in GNSS module, when using the external GNSS antenna 

(receiving side towards the unobstructed sky) through the MMCX to SMA cable connected to 

the instrument's No. 3 ANT port. 

6.4 Connection of Internal GNSS Module (Version B) 

 SAE/SAN-400 Series 

The operating steps for connecting Version B GNSS option to the SAE/SAN-400 series 

instrument are as follows: 

1. Instrument connection: Instrument No. 6 MUXIO interface -> GNSS module No. 8 MUXIO 

interface (with the ribbon cable), GNSS module indicator light blinking that is connected 

successfully. 

2. External GNSS antenna connection: antenna -> GNSS module No. 1 interface (with MMCX 

to SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality modules only): use a Type-C cable to connect 

the GNSS module's No. 7 interface to the power adapter and plug it into an outlet. 

4. Reference clock connection (high-quality module only): MMCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with double-ended MMCX 

cable). 
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Figure 18 SAE/SAN-400 Module Connection with Version B GNSS Module Diagram 

 SAM/SAN Series 

The operating steps for connecting Version B GNSS option to the SAM/SAN series instrument 

are as follows: 

1. Instrument Connection: Instrument No.6 MUXIO interface -> GNSS module No.8 MUXIO 

interface (with MUXIO to Type-C and Ribbon Cable), GNSS module indicator light blinks 

that the connection is successful. 

2. External GNSS antenna connection: antenna -> GNSS module 1 interface (with MMCX to 

SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality module only): Use a Type-C cable to connect the 

GNSS module's No. 7 connector to the power adapter and plug it into an outlet. 

4. Reference clock connection (high quality module only): MCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with MCX to MMCX cable). 

 
Figure 19 SAN/SAM Module Connection with Version B GNSS Module Diagram 

 NX Series 

The NX series instruments have built-in GNSS modules. To use them, you only need to connect 

the antenna, and the receiving side of the antenna is facing to the unobstructed sky. The 

procedure is as follows: 

1. NXE/NXN-400 series: Antenna -> Instrument 4 GA interface (with MMCX to SMA cable). 

2. NXM/NXN series: Antenna -> Instrument 5 GA interface (with MMCX to SMA cable). 

  PX Series 

The PX series instruments have built-in GNSS modules. To use them, you need to connect an 

external GNSS antenna (with the receiving side facing the unobstructed sky) to the instrument's 

No. 14 GA interface via the MMCX to SMA cable. 
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  PXZ Series 

PXZ series instruments have built-in GNSS module, when using the external GNSS antenna 

(receiving side towards the unobstructed sky) through the MMCX to SMA cable connected to 

the instrument's No. 3 ANT port. 

6.5 Connection of External GNSS Module 

The instrument supports access to an external GNSS module of the user's choice via USB to 

serial port. Users can connect the serial output of the module to the following interfaces via USB 

to serial cable: 

Á PX-series flatbed instruments: PX: interface 4, PXZ: interface 7 

Á SA/NX series kernel type instruments: the instrument corresponds to the USB port of the 

host computer 

The system will recognize it as a virtual serial port and parse the received GNSS data. After 

successful locking, the GNSS information can be viewed on the software. 
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7. Analogue IF output 

7.1 Output Intermediate Frequency Signal 

1. Connect the signal generator to the instrument's RF input interface, with the signal 

generator outputting a 1 GHz, 0 dBm signal; 

2. Switch the software to Receiver/IQ Stream mode, ensuring that the instrument outputs a 

stable intermediate frequency (IF) signal; 

3. Output the IF signal generated by the instrument to other measuring instruments for 

viewing through the following interface. 

Á SAE/SAN-400 Series: Interface 2 

Á NXE/NXN-400 Series: Interface 9 

Á PX Series: Interface 10 

7.2 Viewing the Intermediate Frequency Signal 

1. The frequency of the simulated intermediate frequency output signal is between 307.2 MHz 

± 50 MHz, with a maximum output power of -25 dBm and an output impedance of 50 Ω. The 

center frequency of the simulated IF output for each instrument can be found in the IF 

calibration file within the "/bin/CalFile" folder of the instrument's software directory; 

 

Figure 20 View the simulated intermediate frequency output frequency points 

2. Set the "Center Frequency" of the measuring instrument to 311 MHz (refer to the 

corresponding calibration file for the specific value), and keep the other parameters at their 

default settings. Then, view the intermediate frequency output. 
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Figure 21 View the intermediate frequency output signal. 

  



 

Spectrum Analyzer Quick Start Guide 28 
 

8. Modify the IP address of the NX-Series 
instrument 

Go to the official website of HAROGIC (https://www.harogic.com/software-for-harogic-sa-

nx-series-spectrum-analyzer/) to download and extract the "SetDeviceIPaddr.zip "folder to 

your desktop or other directory. 

8.1 Obtaining NX-Series Instrument IP Addresses 

1. Default IP address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable). 

2. Instruments through the direct connection or access to the router, to ensure that and the 

host computer in the same network segment. 

3. Run "SetDeviceIPaddr\SetDevicelPaddr.exe" to check the IP address of the instrument. 

8.2 Modifying NX-Series Instrument IP Addresses 

  Notes on IP modification 

1. To ensure that the IP of the receiver network card and the host computer other non-physical 

connection of the network card's IP address is in a different network segment, in order to 

avoid network conflicts. 

2. IP address cannot end with ".0", ".1" or ".255", these addresses have a special purpose in the 

network (such as network address, broadcast address or gateway address), the use of 

them may lead to communication anomaly ), and their use may lead to communication 

anomalies. 

  IP Modification Procedure 

Run "SetDeviceIPaddr\SetDevicelPaddr.exe". 

1. Single instrument 

Á Enter the IP address (in standard format, e.g., 192.168.3.101) 

Á Enter the subnet mask (CIDR format, e.g. 255.255.255.0) 

Á Press the Enter key to execute the modification, and the prompt "Change ip address 

successfully" indicates success 

 

Figure 22 Single NX Instrument Modification IP 

2. Multiple instruments 

Á Enter the instrument numbers in sequence (each instrument corresponds to a unique 

Device Number, take the instrument with UID 33325110003e0029 as an example) 

Á Enter the IP address and subnet mask (in the same format as above) 

 

https://www.harogic.com/software-for-harogic-sa-nx-series-spectrum-analyzer/
https://www.harogic.com/software-for-harogic-sa-nx-series-spectrum-analyzer/
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Á Press the Enter key to execute the modification, and the prompt "Change ip address 

successfully" indicates success 

 

Figure 23 IP modification for multiple NX instruments 
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9. PX Remote Control Guide 

9.1 Network port direct connection 

1. Connect the driverless docking station with network port to the USB 3.0 interface (USB3) 

on the upper panel of the instrument, and connect it to the network port of the computer 

or embedded instrument via a network cable. Note: USB1 and USB2 are USB 2.0 interfaces, 

it is recommended to use the USB3 interface in preference for better performance. 

 

Figure 24 External drive-free docking station with network port 

2. Exit the current host computer software, enter the PC "Settings -> Network and Internet -> 

Properties", manually configure the IPv4 address (such as "192.168.1.2") and subnet mask 

("255.255.255.0"), ensure that the same network segment as the instrument IP 

("192.168.1.100"), and the instrument IP ("192.168.1.100"). "255.255.255.0"), make sure that it is 

in the same network segment as the instrument IP ("192.168.1.100"). 

 
Figure 25 Configuring IP Addresses and Subnet Masks 

3. Through the cmd execution "ping 192.168.1.100" to verify network connectivity. 
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Figure 26 Test instrument network connectivity (ping command) 

4. Double-click to open the PC host software directory "configuration\Settings.ini" file, set 

Interface = ETH; 

5. 5. From the userdata folder on the desktop of the instrument, enter the "/bin/CalFile" path 

of the software to get the calibration file and save it to the "\bin/CalFile" directory of the 

corresponding software on the PC. 

 

Figure 27 Obtaining Instrument Calibration Documentation 

6. Start the executable programme in the "/bin" folder in the software directory of the PC to 

achieve remote control of the PX series instruments. 

    Note: The instrument and the PC software cannot be switched on at the same time. 
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Figure 28 Remote control of PX instruments by direct connection through the network 

port 

9.2 LAN connectivity 

1. Connect the driver-free docking station with network port to the USB 3.0 interface (USB3) 

on the upper panel of the instrument, and connect it to the network port of the router 

through the network cable. Note: USB1 and USB2 are USB 2.0 ports, it is recommended to 

use the USB3 port in preference for better performance; 

 

Figure 29 Connecting the Router to the Instrument 

2. Click the menu bar "File" -> "Exit", exit the software interface in the instrument; 

3. Click "userdata" -> "Tools" -> "Open Current Folder in Terminal"; 
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Figure 30 Open terminal 

4. In the terminal, type "ifconfig" query the current router to the IP address assigned to the 

instrument, in this case, the IP address is "192.168.31.55"; 

 

Figure 31 Query the dynamic IP acquired by the instrument 

5. Connect the PC to the same router via Wi-Fi to ensure that it is on the same LAN as the 

instrument. Double-click to open the "configuration\Settings.ini" file in the directory of the 

PC host software, set Interface = ETH, Address = "192.168.31.55 " 

6. For the next steps, please refer to step 5 to step 6 of the chapter on the Network port direct 

connection. 

 

Figure 32 Remote control of PX instruments by LAN 
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9.3 OTG Connection 

1. Connect the instrument's USB 3.0 interface (USB3) to the host computer's USB port using a 

USB cable; 

2. Click "File" -> "Exit" in the menu bar to return to the instrument's desktop. Click the "OTG" 

icon on the desktop, and after the window pops up, observe the content of the window: 

Á If the window displays "OTG is enabled," manually restart the instrument 

Á If "OTG is disabled" appears, close the pop-up window, click the "OTG" icon again, and then 

manually restart the instrument 

 

Figure 33 Check the OTG startup status 

3. Refer to Steps 2 – 6 in the Network port direct connection section to configure the network 

and remotely control the instrument. 



 

Spectrum Analyzer Quick Start Guide 35 
 

 


	1. Updated version of the note
	2. System requirements
	3. SA Series Quick Start Guide
	3.1 Safety Instruction
	3.1.1  Power Adapter Selection
	3.1.2  RF Input

	3.2 Using SA Series Instruments
	3.2.1  Connecting the Device
	3.2.2  Driver Installation (Windows)
	3.2.3  Driver Installation (Linux)

	3.3 Running the software
	3.4 External Interface Description
	3.4.1  SAN Series and SAM Series
	3.4.2  SAE Series and SAN-400 Series


	4. NX Series Quick Start Guide
	4.1 Safety Instructions
	4.1.1  Power Adapter Selection
	4.1.2  RF Input

	4.2 Using the NX Series Device
	4.2.1  Connecting the Device
	4.2.2  Configuring the Network

	4.3 Running the software
	4.4 External Interface Description
	4.4.1  NXN and NXM Series
	4.4.2  NXE Series and NXN-400


	5. PX Series Quick Start Guide
	5.1 Safety Instruction
	5.1.1  Safety Rules
	5.1.2  Power adapter selection
	5.1.3  RF Input
	5.1.4  Replacing the Power Adapter

	5.2 First Use of the Instrument
	5.2.1  Switching the instrument on and off
	5.2.2  Charging Indicator
	5.2.3  Running the Software

	5.3 External Interface Description
	5.3.1 PX Series
	5.3.2 PXZ Series


	6. GNSS Application Instructions
	6.1 Version Information
	6.2 GNSS options
	6.2.1  Options Overview
	6.2.2  Interface Description

	6.3 Connection of Internal GNSS Module (Version A)
	6.3.1 SAE/SAN-400 Series
	6.3.2 SAM/SAN Series
	6.3.3 NX Series
	6.3.4  PX Series
	6.3.5  PXZ Series

	6.4 Connection of Internal GNSS Module (Version B)
	6.4.1 SAE/SAN-400 Series
	6.4.2 SAM/SAN Series
	6.4.3 NX Series
	6.4.4  PX Series
	6.4.5  PXZ Series

	6.5 Connection of External GNSS Module

	7. Analogue IF output
	7.1 Output Intermediate Frequency Signal
	7.2 Viewing the Intermediate Frequency Signal

	8. Modify the IP address of the NX-Series instrument
	8.1 Obtaining NX-Series Instrument IP Addresses
	8.2 Modifying NX-Series Instrument IP Addresses
	8.2.1  Notes on IP modification
	8.2.2  IP Modification Procedure


	9. PX Remote Control Guide
	9.1 Network port direct connection
	9.2 LAN connectivity
	9.3 OTG Connection


